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Agenda

» 8:30-9:00 Setup and Socialize
» 9:00 Overview of UAT Goals

» 9:20 Expense Module Overview
» 9:30 Begin Test Scenarios

» 10:30 Break

» 12:00 Lunch

» 2:45 Break

» 4:15 Recap

» 4:30 Question and Answer
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Module Overview

Entry remains the same for Travel
Authorizations and Cash Advances

Updated Expense Report Entry
Add Attachments
Quick-Fill feature
Accounting Detail on expense report entry page
Slight changes to mods
- Mileage Entry
- First or Last Day of Travel
Summary and Submit Acknowledgement

Expense Processing functions the same
Use Report Manager for retrieving reports

4
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Security Role Changes

Expenses Security Changes

The following Expenses roles are going to be dropped as part of the upgrade:

* BOR_EX_MANAGER
e BOR_EX_EMPLOY_DATA
s BOR _EX TAUTH_RESET
s+ BOR_EX MAINT TRANS
s BOR_EX_MOD APR_TRANS
s BOR_EX_REASSIGN
* BOR_EX_SETUP_CONFIG
o This functionality will be included in the BOR_EX_ADMINISTRATION role
s BOR_EX BATCH_PRC will be deleted
* BOR_EX_ADMINISTRATION is a new role.
s BOR_EX_CASH _ADV_PROCESSING is a new role.
* BOR_EX_CASH ADV_APR
o This functionality will be included in the BOR_EX_APPROVAL role
s BOR_EX CASH ADV_ADMIN
o This functionality will be included in the BOR_EX_CASH_ADV_PROCESSING role
e EX_AUD_EXP_TRANS_INQ
* BOR_EX_BUDCHK_PRC
o This functionality will be included in the BOR_EX_PROCESSING role
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Let’s Get Started with UAT!

» Log In

o https://fpre.qgafirst.usg.edu

User ID - same as Production
Password: c0RNhol31sfun
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https://fpre.gafirst.usg.edu/

Personalizations

» My Personalizations > Navigation Personalizations
> You can turn off the Auto-Complete functionality for all pages.

Autocomplete Yes MNa ~ Explain

> You can also set the Drop Down Menu to be permanently sorted alphabetically
(Ascending or Descending)

Drop down Menu Sort Order Mane Ascending » Explain

» Personalize Page

> The AutoComplete can also be disabled at the Component and Page level by
going to the Personalize Page link from the page.

Page Personalization

[ put this page in front (the current tab) when | come into this component.

[ save the state of the View All settings on this page.

Save tabbing order personalized below.
To define new tabbing order, gelect Clear Tabbing Order, then click items to include in desired seguence.
This new Tab order setting may be overridden by the people code command SetCursorpos().

To rearrange tabbing order, select Remove from order, Move up in order, or Move down in order, then click
appropriate items te rearrange.

[ pisable Autocomplete for the entire page.

|:| Disable Autocomplete for the entire component.
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Personalizations

From Home page:
* Click on Personalize Content and choose Menu

User is able to choose

: type: . Menu Option
= Top Menu, Menu (left), or Main menu (left
with icons)
Navigate to My Personalizations > Navigation
Personalizations User is able to select
2 e Choose your menu sort and AutoComplete options and it has the
options (if desired). (Menu sort only applicable to desired effect

Top Menu)
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Authorize Expense Users

» Step 1 - Authorize Expense Users

> Travel and Expenses > Manage Expenses Security >
Authorize Expense Users

- Employee Self-Service > Travel and Expenses > User
Preferences > Delegate Entry Authority

Favorites + Main Menu~ > Travel and Expenses ~ » Manage Expenses Security = > Authorize Expense Users

ORACLE

Authorize Users
Cania Harris

Entering new UserlDs on this page will give those users the ability to enter
expense transactions on behalf of the employee.

Authorize Users

*Authorized User 1D Name
ceulling @, Harris,CaniaY #] [=]
Save

[@* Returnto Search | [=] Notify
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Modify User Defaults

» Step 2
» Travel and Expenses > Manage Employee Information >
Update Profile > User Defaults tab

Favorites ~ | Main Menu~ > Travel and Expenses - > Manage Employee Information - » Update Profile

ORACLE"

Employee Data Organizational Data User Defaults Bank Accounts Corporate Card Information Bank Accounts BOR

Cania Harris

Default Creation Method

*Expense Report Open a Blank Report -
*Time Report Open a Blank Report -
*Travel Authorization Open a Blank Authorization -
Expense Defaults
Report Description Per Diem Range -
Business Purpose - Billing Type -
Originating Location @, Payment Type =y
Expense Location 0, Credit Card -
Transportation ID @, Number of Nights
Accounting Detail Default View Collapsed -

Expense Type Defaults Personalize | Find | | E First'd 10f1 &' Last

Expense Type | Merchant
*Expense Type Payment Type Billing Type
- - - ] [=]
Country @ Select Project ChantFiglds Display
State @, @ Default: Codes
Locality @ © Descriptions
Billing Type - - Codes
[Z] save ||[Eh Returnto Search || Notify [Ek Add
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Review Employee Profile

» Step 3

» Travel and Expenses > Manage Employee Information >
Update Profile > Org Data & Bank Accounts tabs

Favorites = | Main Menu= > Travel and Expenses = > Manage Employee Information = > Update Profile

ORACLE"

Employee Data || Organizational Data || UserDefaults || Bank Accounts

Mischelle Standifer

Corporate Card Information || Bank Accounts BOR

Expenses Processing Data Find | View All First'4' 1 0f 1'%/ Last

Valid for Expenses Yes Default Profile

[&] lgnore Authorized Amounts
Reason for Status Passed All Validation Edits

Per Diem Amount Type Active Amounts -

HR Information Superisor Information

Employee Status Active - =D @,
Hire Date |04/12/1993  |[3] "
ame
*GL Unit|71000 ‘@, Georgia Perimeter College
*Department 5409302 @, Accounting Senices ! -
Designated Approver |dhickey Qd
Hours Per Period [¥]Use Business Unit Default

Default ChartField Values
Default ChartField Values

Personalize | Find | &2 |E First ‘&' 1 0f 1% Last

*GL Unit Fund Dept Program Class Bud Ref Project

71000 @, (10500 @, |6409302 @, |16200 @, |11000 @, (2015 N @,
Cash Advance Level

© Business Unit 0.00 USD

Specific Amount
9 None

Expense Role

“If desired, an expenses role can be associated with this employee. Please note that only one role can be assigned,
per employee, no matter how many jobs they hold within the company.”

Expense Processing Role -
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Modify Bank Account Information

» Step 4

» Travel and Expenses > Manage Employee Information >
Update Profile > Bank Accounts BOR tab

Favorites = | Main Menu~ > Travel and Expenses = > Manage Employee Information = » Update Profile

ORACLE

(Il User Defaults Bank Accounts Corporate Card Information Bank Accounts BOR
Cania Harris
Bank Accounts BOR

EmplID 0252350

Bank ID |
Bank Account #
Account Type | |&,

Prenotification Status -

[E] save ||[@F Returnto Search | |[=] Motify = Add

Employee Data | Organizational Data | User Defaults | Bank Accounts | Corporate Card Information | Bank Accounts BOR
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Modify Bank Account Information

» Step 4 Continued
- Enter info on Bank Accounts tab

Bank Account Info

Bank Account Info || Prenote Info | [F53k

Default e Source
Account

Expenses

Pay to Bank Accounts

StandiferMischelle ID 0124248
& 8
Country|USA (@, United States Seatch
Bank Name &

Branch Name
Bank ID Qualifier 001 |@,  United States Bank Account Type Check Acct

Bank ID (061092387

Bank Account Number 2083442645

DFI Qualifier |01 |, Transit Mumber DFIID 061092387

oK Cancel
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Modify Bank Account Information

» Step 4 continued

» Travel and Expenses > Manage Employee Information > Load
Employee Data

» Run all processes

Load Employee Data

Run Control ID Testing Report Manager Process Monitor Run

Select All Deselact All

Process Request Parameters
Load Organizational Data
Load Employee Bank Data

¥ validate Organizational Data
Load Entry Authorizations

[5] save | =] Motify E: Add || F Update/Display

» Bank account info should appear on Bank Accounts tab
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Expense Report Entry Overview

(Review before beginning Expense Report entry)

Create/Modify combined

K] Travel and Expense Center

Centralized Trawvel and Expense Center

EﬁgExgense Report ﬁ Travel Authorization ﬁ Cash Advance
: gl';reate, modify, print, view or delete an Expense Report Create, modify, print, view or delete a Travel Authorization Create, modify, print, view or delete a Cash Advance
"""""""" = Create/Modify =] Create/Modify =] Create/Modify

= Print = View = View

= View = Delete

= Delete = Cancel
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Expense Report Entry

Add Attachments

Create Expense Report Save for Later | Home | [@ Summary and Submit
Cania Harris (2 Quick Start _ Populate From ~ | GO
*Business Purpose Aftend Meetings - Destination Locag—— @
*Report Description |Meeting in Atlanta % Attachments
Reference @,
Expenses (7
Expand All | Collapse Al Add: | [l MyWallet (0) | #F Quick-Fill Totals (0 Lines) 000 USD
*Diate *Expense Type Description *Payment Type *Amount *Currency
1 - (] - 000 [usp o, [H[=
Expand All | Collapse All Totals (0 Lines) 0.00 usD

Does everyone have a file to use as an attachment?
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Expense Report Entry
Quick—Fill

Quick-Fill L
Help

Enter the date range you want applied to the expenses you wil be adding to the report. Then choose the expense
types and whether you want to add one instance of the expense type or have an entry of that expense type for
each day within the date range.

Date Range
From [01/20/2015 |5 To [p1/23/:2015 |7

Add Expense Types:

One Day All Days Expense Type

2010 FSA Dependent Care B
2010 FSA Medical Care

2011 FSA Dependent Care

2011 FSA Medical Care

2012 FSA Dependent Care

2012 FSA Medical Care

2013 F3A Dependent Care

2013 FSA Medical Care

o 0o o o o o oO

Agency Expense

O o 0o o oD o o g O

B Emp Air Transportation

=}
o

Cancel
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Expense Type Changes

» New Expense Type of Commercial Transp

*Date *Expense Type

02/02/2015 |[%] :Emp Commercial Transp

“Billing T
Ting WP€ 5010 Fa Dependent Care

**Location| 2010 FSA Medical Care
2011 FSA Dependent Care
2011 FSA Medical Care
2012 F5A Dependent Care
2012 FSA Medical Care
2013 FSA Dependent Care
2013 FSA Medical Care
Agency Expense

Emp Air Transportation
02/02/2015 |[%] |Emp Baggage

Emp Breakfast

Emp Commercial Transp

Expand All | Collapse Al Emp Dinner )
Emp Ground Gasoline

Emp Incidentals
Emp Laundry
Emp Lodging
Emp Lunch

Acca

*Description *Payment Type Amount *currency
hd : Taxi to Conference ] Credit Card - 7.00 UsD @, [+] [=]
i Receipt Spiit [¥] Default Rate *Exchange Rate | 1.00000000) b B
= [CINon-Reimbursable Reimbursement Amt 7.00 usb
[ ho Receipt
(] - 0.000 usp e, [#H[=]
Totals (1 Line) 7.00 USD

Information Technology Services ¢ University Syste

m of Georgia

Peoplegoft



Payment Type Change

» New Payment Type of Credit Card

» Old Payment Types still exist
- American Express
o Discover *Payment Type

- MasterCard MNiA(e.g Mileage) . =

o Visa American Express
Cash
Check
Credit Card
Debit Card
Discover Card
Master Card
MNiA (e.g. Mileage)
Prepaid Air (AP)
Prepaid Hotel (AP)
Prepaid Other (AFP)
Visa
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Expense Report Entry

Accounting Detail located below expense line

Create Expense Report Save for Later | @, Summary and Submit

Cania Harris (2 Actions _ Choose an Action > | GO
*Business Purpose Attend Meetings - Destination Location [sT_aNTA @,
*Report Description Meeting in Atlanta &5 Attachments
Reference @,
Expenses (7
Expand All | Collapse Al Add: | [ MyWallst(0) | 4% Quick-Fill Totals (1 Line) 10.00 USD
*Date *Expense Type Description *Payment Type *Amount *Currency
01/22i2015 |[5]  Emp Parking - Cash - 1000 [usp @, [# [=]
Billing Type Intemal  ~ Receipt Spii [ Defautt Rate *Exchange Rate | 100000000 & B
*Location |ATLANTA @, [F] Non-Reimbursable Reimbursement Amt 10.00 usD
DNOReceim
% Accounting Details |7
Chartfields
- . Monetary Currency Exchange .
Amount GL Unit Amount Code Rate Account Fund Dept Program Class Project Bud Re
10.00/ |71000 |, 10.00 USD 1.00000000 |641170 @, |10500/@, |6409302@, (16200 |@, |11000|G, @, 20150
o 1 | v
Totals (1 Line) 10.00 USD

Expand All | Collapse All
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Expense Report Entry
Mileage Entry

Create Expense Report

Cania Harris (7) ]

*Business Purpose Aftend Meetings - Destination Location |ATLANT;°\ |@
*Report Description |Meeting in Atlanta | 4% Attachments
Reference | %

Expenses (7)

Expand All | Collapse All Add: | %MyWallet(U} | ﬁﬁuick—FilI
*Date *Expense Type Description *Payment Type
bl 01/22/2015 |5  Emp Mileage x> NE
*Billing Type Internal - BOR Mileage Entry Detail Page x

*L ocation ATLANTA Help

Create Expense Report

S Aty it Mileage Details

Report ID MEXT

Total Miles Traveled 79

01/22/2015 |[5
Commute/Personal Miles ff
Expand All | Collapse All Reimbursable Miles 72
OK Cancel
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Expense Report Entry

First or Last Day of Travel 75% Calculation

01/22/2015 |[§]  Emp Lunch - 2 {CrediCard = 800, [usp |, [#[=]
“Billing Type Infernal  ~ First or Last Day of Travel [¥] Default Rate *Exchange Rate | 100000000, < B
““Location |ATLANTA @ g Receipt Sl [ Hon-Reimbursable Reimbursement Amt 9.00  USD
[[] no Receipt

Accounting Details (2

Per Diem Info X
Help

Create Expense Report

Deductions for First or Last Day of Travel
Report ID MEXT

Flease selectthe expense that occurred on a first or last day of travel.

Per Diem Amount 9.00 USD
Per Diem Details Personalize | Find | 2 IE First ‘&' 1 of 1 &' | ast
Deduction Deduction -
Percentage Amount Cale Code Deduction Flag
Emp Lunch 25.00
oK Cancel

m Information Technology Services ¢ University System of Georgia Pe Op] esgft



Expense Report Entry

Summary and Submit Acknowledgement

Create Expense Repor‘l [ Save for Later | E‘ﬂExpense Details

Actions ..Choose an Action - GO
*Business Purpose Attend Meetings -

*Description Meeting in Atlanta

Reference @,
Totals (7 & View Printable Version @y View Analytics ] Naotes A Attachments
Employee Expenses (2 Lines) 47.07 UsSD Non-Reimbursable Expenses 0.00 UsSD Employee Credits 0.00 UsSD
Cash Advances Applied 0.00 UsSD Prepaid Expenses 0.00 UsD Supplier Credits 0.00 UsD
Amount Due to Employee 47.07 UsSD Amount Due to Supplier 0.00 USD

[ 1do solemnly swear, under criminal penalty of a felony for false statements subject to punishment by fine of not
more than $1000 or by imprisonment for not less than one nor more than five years, that the above statements
are true and | have incurred the described expenses and the state use mileage in the discharge of my official
duties for the state.

Submit Expense Report
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Create Expense Report

» Step 5

» Travel and Expenses > Expense Report > Create/Modify
» Create a 3 line Expense Report for Emp Breakfast, Emp Lunch,

Emp Dinner
» Save

Create Expense Report
Katherine Smith (¢

*Business Purpose Attend Meetings -

*Report Description UAT

Reference @,

Expenses (2

Expand All | Collapse All Add: | [gy My Wallet (0) | 5’ Cluick-Fill

*Date *Expense Type

02/09/2015 |5
*Billing Type Internal -
**Location ATHENS

Emp Breakfast

Accounting Details (2

OJ

Destination Location | ATHEMNS
o, Atachments

Description

First or Last Day of Travel
Receipt Split

*Payment Type
Credit Card
Default Rate
[C] Mon-Reimbursable
[ No Receipt

Save for Later | @ Summary and Submit

Actions _ Choose an Action v | GO
Totals (1 Line} 6.00 usp
*Amount *Currency .
- 500 [UsD |\ ]
*Exchange Rate | 1.00000000] %, [

Reimbursement Amt 600 UsD

Expand All | Collapse All
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Modify Expense Report

» Step 6
» Travel and Expenses > Expense Report > Create/Modify

Expense Report

Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value Add a New Value

Search Criteria

Report ID: begins with - |

Report Description: pegins with -

Hame: begins with «

Empl ID: begins with @,
Creation Date: - - [=]

[ case sensitive

Clear |Basic Search @ Save Search Criteria
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Modify Expense Report

» Step 6 Continued

MOdIfy EXPEHSE Report Save for Later | @ Summary and Submit
Katherine Smith (2 Actions _Choose an Action - | GO
*Business Purpose Aftend Meetings - Report 0000522851 Pending
*Report Description |JAT Destination Location ATHENS @,
Reference @, % Attachments
Expenses (¢
Expand All | Collapse All Add: | [ MyWallet(0) | % Quick-Fill Totals (3 Lines) 28.00 USD
“Date *Expense Type Description “Payment Type *Amount *Currency
02/09/2015 |[§]  Emp Breakfast - <@ CreditCard - 600 |usp |@, [+ [=]
*Billing Typem [¥] Default Rate *Exchange Rate | 1.00000000, & B
Location ATHENS @ eltg RECEPL Sl [CIMon-Reimbursable Reimbursement Amt 6.00 USD
O He Receipt

Per Diem Info

Expense Report

Deductions for First or Last Day of Travel
ReportID 0000522851

Please select the expense that occurred on a first or last day of travel.

Per Diem Amount 6.00 USD
Per Diem Details Personalize | Fing | 2 | B First ‘4" 1 0f1 ‘&' Last
Deduction Deduction :
Percentage Amount Cale Code Deduction Flag
Emp Breakfast 25.00

Cancel
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Modify Expense Report

» Step 6 continued

» Use First or Last Day of Travel for the
additional meal lines

» Submit the report

Peoplegoft




Create Private Template

» Step 7

» Employee Self-Service > Travel and Expenses > User
Preferences > Create/Update User Template

Favorites - | Main Menu~= > Employee Self-Service = » Travel and Expenses ~ » User Preferences = » Create/Update User Template

ORACLE

User Template

Find an Existing Value Add a New Value

Document Template: |
Template Type: -

Add
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Create Expense Report from

Template

» Step 8

» Travel and Expenses > Expense Report > Create/Modify
» Quick Start menu select A Template and click GO

» Select a Mileage Template, if available

» Add a line for Emp Lodging

» Save the report

Create Expense Report

Katherine Smith (2

*Business Purpose - Destination Location @,

*Report Description & Aftachments A Travel Authorization
Reference @, An Existing Report
Entries from My Wallet
Expenses (2
Expand All | Callapse Al Add: | [ My Wallet(0) | £ Quick-Fill Totals (0 Lines) 0.00 usD
*Date *Expense Type Diescription *Payment Type *Amount *Currency
B - (Ed] - 000 [uso & [# [=]
Expand All | Collapse All Totals {0 Lines) 0.00 usD
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Delete an Expense Report
» Step 9

» Travel and Expenses > Expense Report > Delete

Travel and Expense

Delete an Expense Report
Katherine Smith
Delete an Expense Report (7

Select Report ID Report Description Creation Date Amount Currency

0000522853 Meeting

Delete Selected Reportis)

021212015 45.88 UsD

Travel and Expense

Delete Confirmation
Katherine Smith

“ The selected transaction(s) have been deleted.
OK
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» Step 10
» Travel and Expenses > Expense Report > Create/Modify

Katherine Smith (7 Quick Start | _Populate From
*Business Purpose - Destination Location @, ..Populate From
L A Template
*Report Description & Atachments A Travel Authorization

Reference @,
Entries from My Wallet

Expenses (2

Expand All | Collapse Al Add: | [& MyWallst (0) | £ Quick-Fil Totals (0 Lines) 0.00 USD

*Date *Expense Type Description *Payment Type *Amount *Currency
5 - - 000 [usp &, [+ [=]
Expand All | Collapse All Totals (0 Lines) 0.00 usD
Copy from Existing Expense Report X
From Date [11/12/2013 Ex| To (0211212015 [[5) Search

Expense Reports

Report ID Description Business Purpose Status Created
Select | 0000522852UAT Attend Meetings f\:gg\;ﬁ?d or 921212015
Select | 0000522851UAT Attend Meetings f\:gg\;ﬁ?d or 421212015
Select | 0000522850Test Attend Conference f\:sgﬁfdf‘” 02/04/2015
Select 0000513381GA Summit Conference Travel  Aftend Conference Paid 09/19i2014

Return
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Add Lines Using Quick-Fil

» Step 11
» Click Quick-Fill link

Save for Later | @ Summary and Submit

Create Expense Report
Katherine Smith (2 Actions _Choose an Action - | GO
*Business Purpose Attend Conference - Destination Location |AUGUSTA-RICHMOND COUNTY @,
*Report Description |GA Summit Conference Travel y; Aftachments
Reference
Expenses (2
Expand All | Collapse All Add: | [ My Wallet (0) Totals (1 Line} 7.00 UsSD
*Diate *Expense Type Description *Payment Type *Amount *Currency
09/18/2014 |[5]  Emp Parking - Parkina expsnse for GA Summit Conference . [2)  Cash hd 700 [usp Ja, [H [
*Billing Type Intemal  ~ Receipt Spiit ¥l Default Rate *Exchange Rate | 1.00000000/ 7 [
**Location AUGUSTA-RICHMOND COUNTY Q, [C] Hon-Reimbursable Reimbursement Amt 7.00 UsD
Cno Receipt
Accounting Details (7
Totals (1 Line) 7.00 USD

Expand All | Collapse All
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Add Lines Using Quick-Fill

» Step 11 continued N

Enter the date range you want applied to the expenses you will be adding to the report. Then choose the expense
types and whether you want to add one instance of the expense type or have an entry of that expense type for
each day within the date range.

» Add lines for:
From |02/12/2015 Eﬂ To 021212015 Ei]
> Emp Breakfast
- Emp Commercial Transp Oneibey  AlDeys - ExpenseType

. ] Emp Breakfast
o
Em p ::Od g;]n g [l Emp Commercial Transp |§
- Emp u nc I
- Emp Dinner . e,
] ] Emplncidentals
4 CIICk OK | [l Emplaundy
]  Emp Lodging
] EmpLunch
] ] EmpMileage
] ] Emp Mileage Air
oK Cancel )
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First or Last Day of Travel

» Step 12

» Click the First or Last Day of Travel link on the Emp Breakfast
line

02112/2015 |  Emp Breakfast - & cash - 700 (usp |@ [+ [=]
*Billing Type Intemal  ~ First or Last Day of Travel ¥ Default Rate *Exchange Rate | 1.00000000/ & B
*Location AUGUSTA-RICHMOND COUNTY @ i3 FRecelptopl [C] Non-Reimbursable Reimbursement Amt 7.00  USD
[CIno Receipt

» Check the Deduction Flag and click OK

Per Diem Info

Create Expense Report

Deductions for First or Last Day of Travel

Report ID MEXT
Please selectthe expense that occurred on a first or last day of travel.
Per Diem Amount 0.00 UsSD
Per Diem Details Personalize | Find | &2 | E First'4' 1 of1'*' Last
Deduction Deduction .
e Amount Calc Code Deduction Flag
Emp Breakfast 25.00
Ok Cancel
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First or Last Day of Travel

» Step 12 continued
» Confirm that the Amount was reduced to 75%

02M2/2015 |[ :Emp Breakfast - @ cash - 528 [usD (@ [# [=]
*Billing Type Internal - First orLast Day of Travel [¥] Default Rate *Exchange Rate | 1.00000000) 7 R
**Location AUGUSTA-RICHMOND COUNTY @ Receipt Spit [T Non-Reimbursable Reimbursement Amt 525 UsD
[T No Receipt

» Select First or Last Day of Travel for the other meal lines
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Mileage Entry

» Step 13

» Add a line for Emp Mileage
» BOR Mileage Entry Detail Page should automatically display

» Enter Total Miles and Commute/Personal Miles and click OK
(do not have to enter a value in Commute/Personal Miles)

0211212015 |[/]  Emp Lunch

go0| [uso @ [#][=]

- BOR Mileage Entry Detail Page J
*Billing Type Internal - g : g ge Rate | 1.000000000 o B
*Location AUGUSTA-RICHMOND COUNY  Create Expense Report hent Amt 900 UsSD
Mileage Details
Accounting Details (7 Report ID MEXT
Chartfields
Total Miles Traveled 100
Amount *GL Unit :‘:" oject Bud R
L Commute/Personal Miles jo
9.00] (98000 |@, Reimbursable Miles 90 | @, |2012@
T — = 3
OK Cancel
02/12/2015 |[5]  Emp Mileage - e - | 0.00 |usD & =]
*Billing Type Internal - [¥] Default Rate *Exchange Rate [ 1.00000000 % B
**Originating Location & [ Non-Reimbursable Reimbursement Amt 0.00 usD
**Destination Location AUGUSTA-RICHMOMND COUNTY @, Fl o Receipt

*Reimbursable Milesl X 0.5750
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Mileage Entry

» Step 13 continued

» System calculates the reimbursement and populates the
Amount Field

0211212015 ] Emp Mileage - - [ 5175 |usD = =
“Billing Type  Intemal __ ~ [¥] Defauit Rate *Exchange Rate [ 1.00000000 % B
*Originating Location |ATHENS Q [CInon-Reimbursable Reimbursement Amt 5175 USD
**Destination Location AUGUSTA-RICHMOND COUNTY Q [ No Receipt

*Reimbursable Miles I an x 0.5750

» Mileage can be changed by clicking the Reimbursable Miles
link
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Copy Expense Lines

» Step 14

» From Actions drop down menu, select Copy
Expense Lines

» Click GO

Actions | Choose an Action |;] GO

..Choose an Action

Adjustment Cash Advance

ApplyNView Cash Advance(s)

Associate Travel Authorization

Default Accounting For Report
Totals (7 Ll E¥port to Excel

ser Defaults
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Copy Expense Lines

Step 14 continued

Copy Expense Lines window displays

Can Copy to One Date or Copy to Range of Dates

Select Copy to One Date, check Emp Mileage, and click OK

v v v

v

Copy Expense Lines
Choose the Copy to One Date option if you want to copy each selected line just once using the To Date as
the new expense date, or choose Copy to Range of Dates if you want to copy each line multiple times with
the expense date for the new lines setto each day within the specified date range. Selectthe expense
lines to copy and press OK.
Copy Option
@ Copy to One Date To Date [02/11/2015 |[5]
© Copy to Range of Dates From Date Bl [ include Weekends
To Date EN [T include Holidays
Select Expense Type Expense Date Amount Spent Currency
[ Emp Parking 09/18/2014 7.00 USD
[} Emp Breakfast 021212015 525 UsSD
[} Emp Commercial Transp 021212015 12.00 USD
[} Emp Dinner 021212015 20.00 USD
[} Emp Lodging 021212015 110.00 USD
0 Emp Lunch 02M12/2015 9.00 USD
Emp Mileage 02/12/2015 51.75 USD
oK Cancel
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Copy Expense Lines

» Step 14 continued

» Line is added and even Chartfield info is copied

02/11/2015 E?J Emp Mileage

*Billing Type Internal

-

**0riginating Location ATHEMS

Q
**Destination Location AUGUSTA-RICHMOND COUNTY

*Reimbursable Miles | 90

0.5750

=

- | 5175 |USD
*Exchange Ratel 1.00000000 L B

Reimbursement Amt

Default Rate

[+ =]

[C] Hon-Reimbursable

51.75 UsD

Eno Receipt

Accounting Details (7
Chartfields
r . Monetary Currency  Exchange . X
Amount GL Unit Amount Code Rate Account Fund Dept Program Class Project Bud Re

51.75/ (98000 | @ 51.75 UsD 1.00000000 118100 |@,  [10000/@, |7310000Q, |16400 |@, |11000/3 @, 20153

< 1 |
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Add an Attachment

» Step 15
» Click the Attachments link

Create Expense Report

Katherine Smith (<

*Business Purpose Attend Conference - Destination Location |2 L RICHMOMD COUNTY 3
*Report Description Conference ﬁ Attachments
Reference ]

» Expense Report Attachments window displays
» Click Add Attachment

Expense Report Attachments

Report ID MEXT
Details Personalize | Find | View Al | 22 | E& First'4' 1 0f 1'% Last
File N\ame  Description User Name Date/Time Stamp

=

View

Adding large attachments can take some time to upload, therefore, it is advisable to save
e i efore ina large attachments.

[ d0s 40000 (] d00
Add Attachment

OK Cancel
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Add an Attachment

» Step 15 continued
3 C||Ck BrOWSE File Attachment
I o file selectad.
Upload Cancel
4

File Attachment

RiccardoG.pdf
Cancel

Select a file to attach, click Open, then and click Upload

» File name will display in Expense Report Attachments wmdow

Expense Report Attachments

ReportID MEXT

Details

File Hame Description User Hame

RiccardoG.pdf

Adding large attachments can take some time to upload, therefore, it is advisable to save
the transaction before adding large attachments.

Add Attachment

OK Cancel
m Information Technology Services ¢ University System of Georgia

Personalize | Find |ViewA||||E First'd 10of1 '} Last

Date/Time Stamp

(=]
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Add an Attachment

» Step 15 continued
» Now shows Attachments (1)

» Attachments can be accessed by clicking the
attachments link

» Additional Attachments can be added by clicking
the link again

Create Expense Report

Katherine Smith (%

*Business Purpose Afttend Conference - Destination Location | A CUSTA-RICHMOND COUNTY 2,
*Report Description |Conference ﬁ Attachments (1)
Reference 3@,
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Submit Expense Report

» Step 16

» Click Summary and Submit
Create Expense Report g Save for Later

Katherine Smith (2 Actions _ Choose an Action - | GO
*Business Purpose Aftend Conference - Destination Location [AUGUSTA-RICHMOND COUNTY @
*Report Description |(Conference ﬁ Attachments (1)
Reference @,

» Check the box to acknowledge

Create Expense Reporl [ Save for Later | Ig‘?ﬂExpense Details

Actions ...Choose an Action - GO
*Business Purpose Aftend Conference -

*Description Conference

Reference @,
Totals (= =] View Printable Version e View Analytics (> Motes & Aftachments (1)
Employee Expenses (8 Lines) 266.75 UsSD HNon-Reimbursable Expenses 0.00 USD Employee Credits 0.00 UsSD
Cash Advances Applied 0.00 USD Prepaid Expenses 0.00 USD Supplier Credits 0.00 UsSD
Amount Due to Employee 266.75 USD Amount Due to Supplier 0.00 USD

| do solemnly swear, under criminal penalty of a felony for false statements subject to punishment by fine of not
more than $1000 or by imprisonment for not less than one nor more than five years, that the above statements
are true and | have incurred the described expenses and the state use mileage in the discharge of my official
duties for the state.

Submit Expense Report
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Submit Expense Report

» Step 16 continued
» Click Submit Expense Report

Create Expense Report [ Save for Later | EG] Expense Details

Actions ..Choose an Action - GO
*Business Purpose Aftend Conference -

*Description |Conference

Reference @,
Totals (= =] View Printable Version e View Analytics £ Motes & Aftachments (1)
Employee Expenses (8 Lines) 266.75 USD Hon-Reimbursable Expenses 0.00 USD Employee Credits 0.00 UsSD
Cash Advances Applied 0.00 UsD Prepaid Expenses 0.00 USD Supplier Credits 0.00 UsSD
Amount Due to Employee 266.75 USD Amount Due to Supplier 0.00 USD

[ 1do solemnly swear, under criminal penalty of a felony for false statements subject to punishment by fine of not
more than $1000 or by imprisonment for not less than one nor more than five years, that the above statements
are true and | have incurred the described expenses and the state use mileage in the discharge of my official
duties for the state.

Submit Expense Report

» If there are errors, the system may alert you

EKPEHSES o Expense Report Line Errors X

Expand All | Collapse All ® please enter or update the following information:

Older Transaction - An explanation for the expense line older than 7 days is required. Explain why.

*Date

P (g (0911812014 [[5]

Return
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Submit Confirmation

» Step 16 continued
» Expense Report Submit Confirm window displays

Expense Report Submit Confirm

Create Expense Report
Submit Confirmation

Totals (7
Employee Expenses (& Lines) 266.75 USD Non-Reimbursable Expenses 0.00 USD Employee Credits 0.00 USD
Cash Advances Applied 0.00 USD Prepaid Expenses 0.00 USD Supplier Credits 0.00 USD
Amount Due to Employee 266.75 USD Amount Due to Supplier 0.00 USD
OK Cancel

» Click OK and you will see the View Expense Report page, the
Report ID and status

View Expense Report [E Summary

Katherine Smith (7 Actions _ Choose an Action - | GO

Business Purpose Attend Conference Report 0000522354 Submission in Process
Report Description Conference g AlELTITIE
Reference
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Locate Pending Report from 8.9

» Step 17
» Travel and Expenses > Expense Report > Create/Modify

» Find an Existing Value

Expense Report

Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value Add a New Value

Search Criteria

Report ID;
Report Description:
Empl ID: @,
Report Status: |: V| |F'ending V|
Creation Date: 10/01/2014 B
and
01/06/2015 [#]
[ case Sensitive
Search Clear Basic Search [ Save Search Criteria
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Locate Pending Report from 8.9
» Step 17 continued

» Add a line to the report

» Submit the report
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View an Expense Report
» Step 18

» Travel and Expenses > Expense Report >

Vi
Expense Report
Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value

Search Criteria

Report ID: begins with

Report Description: pegins with

Name: begins with -

Empl ID: begins with - @,
Report Status: = - Paid -
Creation Date: = -

[ case sensitive

Search Clear |Basic Search @E] Save Search Criteria

Search Results
Only the first 300 results can be displayed.

View All First 7y 1-100 of 300 " Last
Report ID Report Description Hame EmplID Report Status Creation Date
9300301375 Schematic Design Review Pope,Sharon F 0120990 Paid Q0710712009
9800301374 Dalton Campus Visit Pope,Sharon F 0120990 Paid 070712009
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W
Print an Expense Report

» Step 19

» Slightly different for Core and Self-Service
users
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Print Expense Report in Core

Step 19 continued
Travel and Expenses > Expense Report > Print
Select a Run Control e repon

Enter any information you have and click Search. Leave fields blank for a list of all values.

v Vv Vv

Find an Existing Value Add a New Value

Search Criteria

Run Control ID: pegins with

[ case Sensitive

Search Clear |BasicSearch @l?] Save Search Criteria

Enter a Report ID or Lookup Report ID
Save, Run

v Vv

Print Report

Run Control ID Testing ReportManager Process Monitor Run

Process Request Parameters

ReportID 2800301367 @, [[include Expense Notes

[5] Save | |[=] Motify Ek Add || & Update/Display
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Report Manager
» Step 19 continued

» Click Report Manager

Favorites - | Main Menu~ > Travel and Expenses ~ > Expense Report = > Print

ORACLE"

Print Report

Run

Run Control ID XPRINT]| Process Monitor

Process Request Parameters

Report ID 0000508726 | @, []include Expense Notes

[5] save ||[E@ Returnto Search |[4=] Previousin List ||45 Nextinlist | [=] Notify |, Add ipdatelmisolay

Favarites - | Main Menu~ > Travel and Expenses = » Expense Report ~ > Print > Report Manager

ORACLE All | Search 3 | Advanced Search  [ol Last Search Results

List Explarer Administration Archives

View Reports For

UserID P35 Type - Last - 1 Days - Refresh
Status + Folder - Instance to
Report List Personalize | Find | view All | 20 | & First'4' 1 0f1 "} Last
Report Pres A Request .
Select D Instance Description DateMime Format Status Details
B 5609196 5383231 BOR_EXCA4500 - BOR_EXC4500 par 12022015 Acrebat oo 00y petails

22915PM  (*.pdf)
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Print Expense Report in Core

» Step 19 continued
» Click .pdf
» Printed Expense Report is displayed

ORACLE Expense Report People Soft Expenses EXC4500
Employee ID / Name Report ID
0274487 | Katherine Smith 0000522550
Refi Report D ipti Report Status
Test Submitted for Approval
Home/Mailing Address Business Purpose
205 Woodstone Drive Attend Conference
Unit#13 Travel Auth ID
Athens, GA, 30605 Institution
Board of Regents
Expense Lines
Date [ Expense Type Non-Reimbursable No Receil | Payment Type Amount
Description ‘Additional Information Merchant Location
Bus GL | Account | Fund DeptiD I Program Class | Project Dist. Amount
G2/0212015 | Emp C ial Transp | Gradit Card 0.00 U0
Train Submitied for Approval
83000 [ 118100 [ 10000 7312100 I I 10.00
020212015 | Emp Mileage | WA (=g Mieage] 4538 U0
Submitted for Approval
03000 [ 118100 | 10000 7312100 I I 4333
020272015 | Emp Breakfast | Cragit Card 525 UsD
Subminted for Approval
03000 [ 115100 [ 10000 7312100 | | 535
Approvals
| Approver Profile | Name | Action | Action Dttm [c |
[ Employee |_Smith, Katherine | Submitted | 0210412015 08:01:23 AM [ |
Approval is required online or by physical signature. Please adhers to your institution’s approval guidelines.
Approved By Date
| do solemnly swear, under criminal penalty of a felony for false statements subject to pprove
pum;hnenth}fm!nfndmpﬂ!anslm'ilnrhwlm m!nﬂvvt fornot less than one nnrJ more A By Date
than five years, thatthe above statements are true lM Ihave incurred the described expenses
and the state use mileage in the discharge of my official duties for the state.
Approved By Date
Employee Signature Date Approved By Date
| Employee Expenses 64.13 USD |
Report ID Employee Phone Department Entered By user Recaipt Submitted Date Print Date Page Number |
0000522850 7312100 QOTEATE 02/04/2013 2/15/2015 Pagelof2
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Print Expense Report in Self-

Service

» Step 19 continued

» Employee Self-Service > Travel and Expenses > Expense
Report > Print > select report and click Print Expense Report

link

Expense Report

Katherine Smith
Description UAT

Business Purpose Aftend Meetings

Report 0000522851

Submitted for Approval

5 Print Expense Report

Date Expense Type Naon-Reimbursable No Receipt Payment Type Trangaction Amt Exchange Rate Amaount

Description Additional Information Merchant Location

02/08/2015 Emp Breakfast Credit Card 450 UsSD 1.00000000 450 UsSD
& ATHENS

02/08/2015 Emp Lunch Credit Card 5.25 UsSD 1.00000000 5.25 UsSD
ATHENS

02/09/2015 Emp Dinner Credit Card 11.25 USD 1.00000000 11.25 USD
Ed ATHENS

Employee Expenses 21.00 UsSD Non-Reimbursable Expenses 0.00 USD Amount Due to Supplier 0.00 USD

Cash Advances Applied 0.00 USD Prepaid Expenses 0.00 USD Amount Due to Employee 21.00 USD
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Create a Travel Authorization

» Step 20

» Travel and Expenses > Travel Authorization >
Create/Modify

Create Travel Authorization

» Add lines for [oeierensiy ..
- Emp Mileage
- Emp Lodging I = e @
> Em p Parki ng Destination Location ATLANTA a

General Information

*Date From [02/18/2015 |[5] *Date To [02/18/2015 |[5] Atachments
L
} S u b I I I It Accounting Defaults More Options -~ | GO
Details (7 Personalize | Find | 2 | & First'4' 1-4 of 4 '}/ Last
Select *Expense Type *Date *Amount Currency *Payment Type *Billing Type
[} Emp Mileage - 02M1812015/[5] 57.50 USD N/A (e.g. Mil ~  Internal ~ *Detail [+]
&} Emp Lodging - 0218120155 0.00 USD CreditCard +  Internal ~ *Detail [+]
[ Emp Parking - 02/18/2015/[5y) 0.00, USD Cash + Internal ~ *Detail [+.]
- Internal - [+]
Copy Selected Delete Selected Check For Errors Mew Expense - Add
Totals
Authorized Amount 57.50 UsSD

Update Totals

Save for Later Submit Create A Cash Advance
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a Template

» Step 21

» Travel and Expenses > Travel Authorization
> Create/Modify

» Quick Start menu, select A Template

» Click GO

Create Travel Authorization
Travel Authorization Entry
Lser Defaults

Daphne Burch
Quick Start A Template - GO
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Create a Travel Authorization from

a Template

» Step 21 continued

» Update the information

» Save the Travel Authorization

F‘ Sawved |
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Delete Travel Authorization
» Step 22

» Travel and Expenses > Travel Authorization >
Delete

- |If you create a travel authorization and decide not to process it,
you can delete it before you submit it for approval.

- |If you submit a travel authorization and the approver returns it to
you, you can delete the travel authorization.

Select and click Delete Selected Authorization(s)

Travel and Expense

Delete a Travel Authorization
Katherine Smith

v

Travel Authorizations

Select Description Authorization 1D Date From Date To Amount

testing tauth delete 0000425453

021812015 02M18/2015 9.00 UsSD

Delete Selected Authorization(s) Travel and Expense

Delete Confirmation
Katherine Smith

“ The zelected transaction(s) have been deleted.
OK
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Create a Travel Authorization from

an Existing Travel Authorization

» Step 23

» Travel and Expenses > Travel Authorization >
Create/Modify

» Quick Start menu, create from An Existing
Authorization

» Click GO
» Select a Travel Authorization
» Update line information

|
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Add an Attachment to the

Travel Authorization

» Step 24
» Click the Attachments link

Create Travel Authorization

Travel Authorization Entry

Katherine Smith User Defaults
Quick Start A Blank Authorization - GO
Genera | Information
*Description Aftend Conference Authorization ID MEXT
*Business Purpose Aftend Conference - Comment Ed|
Destination Location AJGUSTA @,

*Date From |03/01/2015 |[5 *Date To 03/03/2015 3] Attachments

» Add an Attachment
» Submit
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View a Travel Authorization

» Step 25
» Search for a view a Travel Authorization

Travel Authorization

Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value

Search Criteria

Authorization 1D begins with

4

Description: begins with -
Name: begins with
Empl 1D: begins with - @,
Status: = - -
Creation Date; = -
[[| case Sensitive

Search Clear |Basic Search El'. Save Search Criteria
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Print a Travel Authorization

» Step 26

» Travel and Expenses > Travel Authorization > View

S Prl nt Vla brOWSer View Travel Authorization

Travel Authorization Details
Casey Durden User Defauits

General Information

Description Travel to target schools/ Fair
Business Purpose Recruitment, Admissions

Status Closed

Destination Location JONESEORO

Date From 03/252008 Date To 03/Z5/2000
Accounting Defaults
Details (2
Date *Amount Currency
Auto Mileage - Personal Full 03/25/2008 22825 USD
Lodging 032572000 77.00 UsSD
Dinner 03252008 15.00 USD
Breakfast 03/25/2008 8.00 USD
Lunch 0325:2002 7.00 UsSD
Totals
Authorized Amount 332.25 UsD
Less Non-Approved 0.00 UsD
Due Employee 333.25 USD
Action History
Role Name

Durden,Casey Michelle

1=t Level Finance Dept Manager Braswell Randy L

|&" Retun to Search % | Previous in List 4 | Mext in List = Motify

Information Technology Services ¢ University System of Georgia

Authorization ID

Comment

Last Update Dttm

Personaiize | Find | 2 | B First

8700300157

Morthshide. Pemry, Houston County, Warmner Robins.
High. Drive to Momrow for Colle

0a/26/2008 By rbraswel
12:00:004M

1-50f5 " Last
*Payment Type *Hilling Type
Cash Internal “Dretsil
Cash Intzrmal “Detail
Cash Intermal *Diatail
Cash Interral “Dretsil
Cash Internal “Dretail

Personalize | Find | (7 | B First' ! 1-20f2'F Last

Action
Submitied

Approved

DatelTime
03/25/2008 2:48:31AM

03/25/2000 2:54:22AM

Peoplegoft



Print a Travel Authorization

» Step 26 continued
» Employee Self-Service > Travel Authorization > Print

To print this report, please use your browser's print feature.

PeopleSoft.

Travel Authorization
Report Date 02/15/2015

Cynthia Warden Report Time 2:39:54PM
Authorization ID 2400300577 Employee ID 0010768
Description June 23-24 2009 Status Closed

Business Purpose Recruitment, Admissions
Date From 08/23/2009 To 06/24/2009

Comment Georgia Perimeter College visits clarkston and newton

Expense _
Date P Merchant Amount Description
Type
06/2312000 3850 USD  CLARKSTON
06/24i2000 3200 USD  GWINNETT COUNTY
Total 71.50 USD
Hon-Reimbursable Expenses 0.00 USD
Total Authorized 7150 UsSD

| certify that the information provided above is an accurate estimate of travel-related costs that
are to be incurred by me.

Employee Signature Date

Approved By Date
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Create a Cash Advance

» Step 27

» Travel and Expenses > Cash Advance >
Create/Modify

» Add one line for Registration Fee of $100
» Submit

Create Cash Advance Save for Later
Daphne Burch
*Business Purpose Attend Conference - Reference @,
*Advance Description Registration Fee gﬂgﬂ User Defaults

[& Import ATM Advances

Cash Advance (7 & View Printable Version (> Motes A, Attachments
*source Description *Amount Currency Apply Tax
Employee Advnce EFT Paymel = |Registration 100.00| USD [#] [=]
Totals
Advance Amount 100.00 USD

By checking this box, | certify the advances submitted are accurate and comply with expense policy.

Submit Cash Advance
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Create Another Cash Advance

» Step 28

» Travel and Expenses > Cash Advance >
Create/Modify

» Create a third Cash Advance
» Submit

Create Cash Advance Save for Later
Daphne Burch
*Business Purpose Aftend Meetings - Reference @

*Advance Description Meal for Meeting 5&% User Dafaults

[E ImportATM Advances

Cash Advance (2 5 View Printable Version (:_) Motes ﬁ Attachments
*Source Description *Amount Currency Apply Tax
Employee Advnce EFT Paymer = [Meal at Meeting 10.00| USD [+ =]
Totals
Advance Amount 10.00 UsD

By checking this box, | certify the advances submitted are accurate and comply with expense policy.
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Create Another Cash Advance

» Step 29

» Travel and Expenses > Cash Advance >
Create/Modify

» Add line of your choosing
> Save Create Cash Advance

Daphne Burch

*Business Purpose Attend Meetings - Reference @

*Advance Description Meal for Meeting 5&% User Dafaults

[& Import ATM Advances

Cash Advance (2 5 View Printable Version (:_) Motes ﬁ Attachments
*Source Description *Amount Currency Apply Tax
Employee Advnce EFT Paymer = [Meal at Meeting 10.00| USD [+ =]
Totals
Advance Amount 10.00 UsD

By checking this box, | certify the advances submitted are accurate and comply with expense policy.

Submit Cash Advance
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Delete a Cash Advance
» Step 30

» Travel and Expenses > Cash Advance >
Delete

» Select and click Delete Selected Advance(s)

Travel & Expenses - Cash Advance Report

Delete Cash Advance Report
Daphne Burch

Cash Advance Information

Select Advance ID Description Creation Date Amount Currency
0000406606 Meal for Meeting 02152015 10,00 UsSD

Delete Selected Advance(s)

Travel & Expenses - Cash Advance Report
Delete Confirmation
Daphne Burch

“ The selected transaction(s) have been deleted.
OK
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Run BOR_EX_WF_BLACK_HOLE

» Step 31
» Reporting Tools > Query > Query Manager

» Search for BOR_EX_WF_BLACK_HOLE
» Run for your Business Unit to locate

transactions for approval

BOR_EX_WF_BLACK_HOLE - EX trans to be reassigned

Business Unit: E4DDD QJ

View Results

Download results in . Excel SpreadSheet CSV TextFile XMLFile (4 Kb)

Wiew All

=R L R S R R

g

User Id
adamscar
BURCHDAP
BURCHDAP
067606109
adamscar
adamscar
CameronReagin
CameronReagin
CameronReagin

10 CameronReagin
11 CameronReagin
12 CameronReagin

Report ID
0000406605
0000411382
0000411382
0000423580
0000425448
0000425450
0000504275
0000504275
0000512580
0000512590
0000512580
0000512590

Type
CA
TA
TA
TA
TA
TA
ER
ER
ER
ER
ER
ER

Dept Project Unit

1043010
1001010
1025070
1005030
1043010
1043010
1001050
1025030
1001010
1001010
1025070 1588
1025070 1588

24000
24000
24000
24000
24000
24000
24000
24000
24000
24000
24000
24000

1]
0010606
0010410
0010410
0006252
0010606
0010606
0005933
0005933
0010034
0010034
0010034
0010034

Hame
Burch,Daphne
Gregerson,Robert
Gregerson,Robert
Plaspohl,Sara 3
Burch,Daphne
Burch,Daphne
Hall,Michael R
Hall Michael R
MNess Traci
MNess Trac
MNess Traci
MNess Traci
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Status
SUB
DEM
DEM
CL3S
SUB
SuUB
PD
PD
PD
PD
PD
PD

Submit Dt
021512015
1210212011
1210212011
09/0712014
0211312015
021312015
0412212014
0472212014
09/08/2014
09/09/2014
09/08/2014
09/09/2014

First 3, 1-12 of 12 1, Last

Total Approver Type Budget Status

100.000 EXAPPRVER
75.000 EXAPPRVER
75.000 EXAPPRVER

430.480 EXAPPRVER

297.500 EXAPPRVER

335.000 EXAPPRVER

1198.900 EXAPPRVER
1198.900 EXAPPRVER

604.470 EXAPPRVER

604.470 PROJSUPP

604.470 EXAPPRVER

604.470 PROJSUPP

W

v

SEEEEE =

=
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Worklist

» Step 32

» Log in as Dept Manager1 and navigate to the
Worklist

Favorites - | Main Menu ~
Home Add to Favorites Sign out
ORACLE
Personalize Content | Layout
Worklist
Worklist for CameronReagin: Cameron Reagin
Worklist Filters - Feed
Worklist ltems Personalize | Find | View All | 2 | B First ‘&' 1 of 1 &' |Last
From Date From Viork Item Worked By Activity Priority Link

GLJournalApproval, 871, 24000,
1901-01-01, M. 0,
BUSINESS UNIT:24000
MaynorMaurena D. 02M12/2015 Approval Routing  Approval Workflow 1-High ~ JOUEMNAL [D:0000150418 Mark Worked Reassign
JOURNAL DATE 2015-02-12
BUSINESS UMIT LM:24000
EDCRAQA
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Worklist Priority

» Step 33
» Give any transaction a Priority

Worklist
Woaorklist for CameronReagin: Cameron Reagin
Detail View Worklist Filters ~ [ ] Feed
Worklist ltems Personalize | Find | View All | 2 IE First'*' 1of1 "2 Last
From Date From Wiork Hem Worked By Activity Priority Link

GLJournalApproval, 871, 24000,
1901-01-01, M. 0,
BUSINESS UNIT:24000
MaynorMaurena D. 02M2/2015 Approval Routing  Approval Workflow 1-High : JOURMAL [D:0000150418 Mark Worked Reassign
JOURMAL DATE2015-02-12
BUSINESS UMNIT LM:24000
ROCRADA

2-Medium
3-Low
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Approve Transactions Dept
Manager]

» Step 34
» Select transactions from the Worklist

» Budget Check (if applicable)
» Approve

» Perform Send Back on one Expense Report

- Enter a comment
> Click Send Back

3
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LE
» Step 35
» Reporting Tools > Query > Query Manager

» Search for BOR_EX_WF_BLACK_HOLE

» Run for your Business Unit to locate
transactions for approval

Peoplegoft




Approve Transactions

» Step 36

» Log In as Approver

» Navigate to Worklist

» Approve Transactions
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Mark Cash Advance for Close

» Step 37

» Travel and Expenses > Close Expenses >
Mark Cash Advance for Close

Mark Cash Advance for Close

Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value

Search Criteria

Search by:  Advance ID ~ Degins with |

Search |Advanced Search

Peoplegoft




Mark Expense Report for Close

» Step 38

» Travel and Expenses > Close Expenses >
Mark Expense Report for Close

Peoplegoft




Close Liability

» Step 39

» Travel and Expenses > Process Expenses > Expense

Processing
» Select Run Control
» Enter Business Unit
» Check Close Liability ONLY
b SAVE e | sessimsns i

} Ru n Run Control ID Report Report Manager Process Monitor

Select All Deselect All Refresh

Ifthe run control id is new, hit "Save’ first and then ‘Refresh’ to update the transaction counts.

Process Request Parameters

Expense Reports Cash Advances
[C] stage Payments 0 0
[Tl publish to Payroll
[ post Liabilities 0 0
[l post Payments 0 0
[CJunpost Expense Report 0
Ml cancal Pavmen
S

[§)save ||[&r Returnto Search ||45] PreviousinList | |45 MextinList ||[Z] Motify

Expense Processes | Selected Business Units

m Information Technology Services ¢ University System of Georgia

Run

Payments
1

0

Transfer To Pay Cycle Process

] Stage Time to Project Costing
or

[Tl publish Elapsed Time

[C] Advance Reconciliation

[C] Airline Ticket Reconciliation

] Unstage Payments

[Clupdate Paid Statuses

Time Reports

0

Reconciliations
0

0

Payments
1

0

Ey Add Update/Display
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Stage Transactions

» Step 40

» Travel and Expenses > Process Expenses > Expense
Processing

» Un-Check Close Liability
» Check Stage Payments
} S ave Expense Processes Selected Business Units

Ru n Run Control ID Report Report Manager Process Monitor Run

Select All Deselect All Refresh

Ifthe run control id is new, hit“Save’ first and then ‘Refresh’ to update the transaction counts. Transfer To Pay Cycle Process

Process Request Parameters

Expense Reports Cash Advances Payments Time Reports
tage Payments 0 0 1 0o Stage Time to Project Costing

or 0

[ publish to Payroll 0 [E publish Elapsed Time
[ post Liabilities 0 0 Reconciliations

[C] Advance Reconciliation 0
[ post Payments 0 0

[C] Airline Ticket Reconciliation 0
0o Unpost Expense Report 0

Payments
[Ccancel Payments 0 [l unstage Payments 1
[ close Liability 0 0 [Clupdate Paid Statuses 0
[§] 5ave ||[Ch Return to Search 45| Previous in List | |4=5] Mextin List [=] Motify Ey Add Update/Display

Expense Processes | Selected Business Units
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Demo Paycycle
» Kate will demo an Expenses Paycycle
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Expense Paycycle

Who runs paycycles?

After staging, run BOR_EX_DUE query
Run Payment Selection

View paycycle Details. Under Payment Action,

nlace a payment on Hold and select a Hold
Reason. Click Save.

Run Payment Creation
View Trial Register

Finish paycycle
Run BOR_EX_UNPOSTED_PAYMENTS
Void and do not reissue a check payment
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Update Paid Statuses and Post

Payments

» Step 41

» Travel and Expenses > Process Expenses > Expense

Processing
» Un-Check Close Liability
» Check Stage Payments
N Save Expense Processes || Selected Business Units

Run Control ID Report Report Manager Process Monitor Run

Select All Deselect All Refresh

Ifthe run control id is new, hit"Save’ first and then ‘Refresh’ to update the transaction counts. Transfer To Pay Cycle Process

Process Request Parameters

Expense Reports Cash Advances Payments
0o Stage Payments 0 0 1 0o Stage Time to Project Costing
or
[CIpublish to Payroll 0 [Tl publish Elapsed Time
=TT T 0 0
[C] Advance Reconciliation
#post Payments 0 0
[C] Airline Ticket Reconciliation
DUnpost Expense Report 0
[Fcancel Payments 0 . . ——
[CIclose Liability 0 0 [ update Paid Statuses

[5] save ||[Eh Returnto Search ||4F] PreviousinList ||4E] NextinList ||[Z] Notify

Expensze Processes | Selected Business Units
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Run BOR_EX_OPEN_CASHADV_BAL

Step 42

Reporting Tools > Query > Query Manager
Search for BOR_EX_OPEN_CASHADV_BAL

Run for your Business Unit to locate open Cash Advances that
have not been applied to Expense Reports

v

v

v

v

BOR_EX_OPEN_CASHADV_BAL - Account 132300 Recon by Emplid

Business Unit: p.:mun ]

View Results

Download results in ;. Excel SpreadSheet CSVTextFile XMLFile (6 kb)

View All First gy 1-19 0f 19 1, Last
Unit Open Hem Key Name Accoun t Descr Sum Amount
1 24000 0006008 DeaverWilliam 132300 Travel Advance- Employees 1174.000
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Add a Cash Advance to an Expense

Report

» Step 43

» Travel and Expenses > Expense Report > Create/Modify

» Add lines

Create Expense Report

Save for Later | [ Summary and Submit

Daphne Burch (7 Actions ;. Choose an Action GO
*Business Purpose Attend Conference - Destination Location |AT|ANTA @, ..Choose an Action
*Report Description Atlanta Conf &, Atachments I:‘-n:‘-)
Reference @, Associate Travel Autnorization
Copy Expense Lines
Expenses ) Drefault Accounting For Report
Expand All | Collapse Al Add: | [y My Wallet(0) | 4% Quick-Fill Totals {1 E’;peﬂrrngfjﬁz‘
*Date *Expense Type Description *Payment Type *Amount *Currency
0211212075 |5 Redistration v @ Check - 10000 [usD @, [#] [=]
*Billing Type Internal  ~ Receipt Spiit [ Default Rate *Exchange Rate | 1.00000000) 7 [
[C] non-Reimbursable Reimbursement Amt 10000  USD
[ he Receipt
Accounting Details (7
Expand All | Collapse All Totals (1 Line) 100.00 USD

» From Actions Menu, select Apply/View Cash Advances
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Apply Cash Advance to an Expense

Report
» Step 43 continued

Create Expense Report

Apply Cash Advance(s)

Cash Advance Information

*Advance ID Advance Amount Balance
Rate
| @, 0.000 0.00
Add Cash Advance Update Totals
Total Advance Applied 0.00 UsD
Totals (1 Line) 100.00 USD
Total Due Employee 100.00 UsD
OK

» Lookup Cash Advance and click Add Cash Advance
» Submit the Expense Report

m Information Technology Services ¢ University System of Georgia

ReportID MEXT

Total Applied

0.00 UsSD
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Create an Expense Report from a

Travel Authorization

» Step 44

» Travel and Expenses > Expense Report > Create/Modify
» Quick Start Menu, select Populate From a Travel Authorization

Create Expense Report

Daphne Burch (7

Save for Later | @ Summary and Submit

Quick Start | _papulate From =] | @0

...Populate From

*Business Purpose Aftend Meetings Destination Location [ATLANTA a,
- ATemplate
*Report Description test yf,_ Attachments
Reference QL An Existing Report
B Entries from My Wallet
Expenses (7
Expand All | Collapse Al Add: | [ My wallet (0) | #F Quick-Fill Totals (0 Lines}) 0.00 USD
*Date *Expense Type Descriptio *Payment Type *Amount *Currency
[ - 0.000 [usp @ [H [=]

Expand All | Collapse All

» Select Approved Travel Authorization
» Submit the Expense Report
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Totals (0 Lines) 0.00 USD
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Cancel a Travel Authorization

» Step 45

» Travel and Expenses > Process Expenses > Cancel Travel
Authorizations

» Select a Travel Authorization and click Cancel

Cancel Travel Authorization

Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value

Search Criteria

EmplID: begins with « | @,
Mame: hegins with -

[[] case Sensitive

Search Clear |Basic Search [:{.3] Save Search Criteria
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N\\} ‘»

Reset Expense Report

» Step 46
» BOR Menus > BOR Expenses > BOR EX Month
End > Reset Expense Report

Reset Expense Report

Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value

Search Criteria

Report ID: == - ]

Report Status: = - -
Empl IDx begins with

Hame: begins with -

Accounting Date: = - [#1]

[[| case Sensitive

Search Clear |Basic Search E:LE] Save Search Criteria
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Reset Travel Authorization

» Step 46

» BOR Menus > BOR Expenses > BOR EX Month
End > Reset Travel Authorization

Reset Travel Authorization

Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value

Search Criteria

Travel Authorization ID: begins with « | B
Travel Authorization Status: - - -
Empl 1D: begins with -

Hame: begins with -
Accounting Date: - El

[[| case sensitive

Search Clear |Basic Search @E} Save Search Criteria
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Reassign an Expense Transaction

4
4

Step 48

Travel and Expenses > Manage Expenses Security > Reassign

Approval Work

Enter USERID

Enter Reassign Work To
Select Transaction
Click Reassign

Define Security

Reassign Work

Burch,Daphne A

Select All O DeselectAl Reassign

Transaction Information

Select Transaction Type Total Amount Name
] Travel Authorization 75.00 USD Gregerson, Robert
Select All [0 DeselectAl Reassign

[&r Return to Search | |[=] Notify

m Information Technology Services ¢ University System of Georgia

Persona lize | Find |ViewA|||@|E First'4' 1 0f1“*' Last
Submission
Empl IDv Report ID Date Role
0010410 0000411282  12/02/2011 EXP APPROVER
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View Expense Report Accounting

Entries
» Step 49

» Travel and Expenses > Manage Accounting > View/Adjust

Accounting Entries > Expense Report Acctg Entries
» Select a report and view accounting entries

Expense Report Acctg Entries

Masters, Mark ReportID 00005225230

Employee ID 00032315

Journal Entry Detail Find | View All First'*' 1of2 "' Last

Journal Template EXACCRUAL
Distribution Status Distributed

Expense Report Journal Lines
=

Chartfields || Currency || Journal Information

ool Line Long Hame GL. Account Fund Dept
Sequence Unit

0 1 Expense Distribution 21000 641110 20000 1201315

1| 1 [

[GF Returnto Search || 15| Previous inList | 4= MextinList | |[Z] Motify
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Personalize | Find | View All ||@ First '@ 1 of2 ‘&' Last
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Review Budget Check Exceptions

» Step 50

» Commitment Control > Review Budget Check Exceptions >
Travel and Expenses > Expense Sheet or Travel Authorization

Expense Sheet Exceptions Line Exceptions

ReportID 0000518222 &

*Exception Type ; Warnin Override Transaction o 0 m i
Maximum Rows| 100 More Budgets Exist
Search Advanced Budget Criteria
Budgets with Exceptions Personalize | Find | View All IﬁI IE First'* 1-10 of 15 '*' Last
Budget Override Budget Chartfields
Details Business Unit E:gs;r Exception More Detail Ogule;;edte Transfer
1 & 51000 ORG Exceeds Mon-Cntrl Budget More Detail GoTo . E
2 @l 51000 ORG Exceeds Non-Cntrl Budget More Detail GoTo ,'ﬁ
3 @l 51000 ORG Exceeds Non-Cntrl Budget More Detail GoTo . E
4 @l 51000 ORG Exceeds MNon-Cntrl Budget More Detail GoTo ,'ﬁ
5 [ 51000 ORG Exceeds Non-Cntrl Budget More Detail GoTo . §
6 [} 51000 ORG Exceeds Mon-Cntrl Budget More Detail GoTo . §
7 @l 51000 ORG Exceeds Mon-Cntrl Budget More Detail GoTo ,'ﬁ
8 & 51000 ORG Exceeds Mon-Cntrl Budget More Detail GoTo . E
9 @l 51000 ORG Exceeds Mon-Cntrl Budget More Detail GoTo ,'ﬁ
10 &) 51000 ORG Exceeds Non-Cntrl Budget More Detail GoTo ... H

[5] save ||[E" Returnto Search | |15 Previousinlist ||+= MNextinList ||[=] Nofify

Expense Sheet Exceptions | Line Exceptions
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Adjust Paid Expenses

» Step 51
» Creates Journal Expense Report

Journal Expense Report

Medify Journal Entries for An Expense Report
Daphne Burch ReportID MNEXT

General Information
To create a Journal Expense Report, select an Expense Report to copy from.
*Journal Report ID | @,

*Report Description

1) Use the Check Box to select lines for posting. Lines that are not selected will not be posted.
2) Click on Expense Type to modify the accounting.
3)When it is ready for posting, press Submit for Posting.

Expense Report Lines
Expense

Select S Date Merchant Amount Currency
[l 0.00 USD Reimburseable
HNotes:
(ED
Submit For Posting
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Adjust Paid Expenses

» Step 51 continued

Journal Expense Report
Modify Journal Entries for An Expense Report
Daphne Burch ReportID NEXT
General Information
To create a Journal Expense Repont, select an Expense Report to copy from.
*Journal Report ID | 0000513502 Ocu

*Report Description |Correct 513502

1) Use the Check Box to select lines for posting. Lines that are not selected will not be posted.
2) Click on Expense Type to modify the accounting.
3) When itis ready for posting, press Submit for Posting.

Expense Report Lines

Select Expense Type Date Merchant Amount Currency
[ Emp Dinner 09M16/2014 15.00 USD Reimburseable
] Emp Dinner 0911712014 20.00 USD Reimburseable
[ Emp Dinner 09/18/2014 20.00 USD Reimburseable
] Emp Breakfast  09/17/2014 7.00 USD Reimburseable
[l Emp Lunch 09/17/2014 9.00 USD Reimburseable
] mp Lunch 09/19/2014 6.75 USD Reimburseable
0911712014 16.50 USD Reimburseable
& Emporound — por19r2014 £4.19 USD Reimburseable
Notes:
Submit For Posting
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Adjust Paid Expenses

» Step 51 continued

» Change Accounting Detail
» Click OK

Journal Expense Report
Accounting Detail
Daphne Burch ReportID MEXT

Areversing entry has been automatically created for each distribution, from the original expense report.
The adjusting entries (i.e. amount greater than zero) may have any of their accounting values modified.
All of the distribution amounts added together must equal zero for this expense line.

Accounting Detail

Chartfields | ==k

Set Personalizations | Find|@|@ First ‘4 1-2 of 2 ‘& Last

. . Monetary Currency Exchange :
Amount GL Unit Amount Code Rate Account Fund Dept Program Class Project
-16.50 24000 -16.50 USD 1.00000000 641170 10000 1043010 16200 11000
16.50) 24000 OJ 16.50 UsD 1.00000000 ‘1‘18‘1DD| OJ ‘IDDDEQJ ‘1E|=1-3E|‘1EQJ 16200 OJ 11000 OJ QJ
4|

] |

Add Add additional adjusting entries.

OK

» Click Submit for Posting
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Print Cash Advances by Dept
Report

Step 52

Travel and Expenses > Manage Accounting > Print Reports >
Cash Advances by Dept

Select Run Control

Enter GL Unit and Department
Save and Run

Retrieve from Report Manager

‘‘‘‘‘

ORACLE Cash Advances by Department Page | Page 10f 2
EXC5600 PeopleSoft Expenses Run Date: | 2/15/2015
Report F
GL Business Unit | 51000 Waldosta State University
Department | 1431080 Athletic Operations.

EmployeelD/Name 0228674

Nolin,Rebecca

Advance ID | Reference Business Purpose Source | Account Project ID Product Amount
0000406151 Athletic Events/Team CHK 132300 TrvAdvEmpl 2,500.00 USD
0000406193 Athletic Events/Team CHK 132300 TrvAdvEmpl 1,000.00 USD
0000406217 Athletic Events/Team CHK 132300 TrvAdvEmpl 1,000.00 USD
0000406241 Athletic Events/Team CHK 132300 TrvAdvEmpl 2,000.00 USD
0000406372 Athletic Events/Team CHK 132300 TrvAdvEmpl 2,000.00 USD
0000406393 Athletic Events/Team CHK 132300 TrvAdvEmpl 2,000.00 USD
Total For Account 132300 TrvAdvEmpl | 10,500.00 USD |
EmployeelD/Name 0248768  Sisler,Richard
[ Ady D | Refe | Busi Purpose | Source [ Account [ Project ID [ Product [ Amount |
| 0000406045 | Attend Meetings [ CHK | 132300 TrvAdvEmpl | 400.00 USD |
Total For Account 132300 TrvAdvEmpl | 400.00 USD |
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Print Employee Top Spenders

Report

4

Step 53

Travel and Expenses > Manage Accounting > Print Reports >
Employee Top Spenders

Select Run Control

Enter GL Unit, Department, From Date, Through Date
Save and Run

Retrieve from Report Manager

ORACLE Employee Top Spenders Page: 10f1

EX_ESPD_XRPT PeopleSoft Expenses Run Date: 2/15/2015
Report P
GL Busi Unit | 24000 Armstrong State University From Date | 07/01/2014
Dep 1037010 Admissions and Recruitment Through Date | 02/15/2015
GL Business Unit: 24000 Armstrong State University
Currency Code: UsD US Dollar
Employee ID Employee Department Total Number of Total Monetary Amount
Expense Lines

00107638 Warden,Cynthia R. 1037010 95 5090.08
0283452 Hebert,Henry 1037010 103 4797.35
0252378 Cronon,Haley 1037010 95 3260.38
02358192 Danald, Tiffany 1037010 30 1991.87
0010338 Cary,Rolinda 1037010 32 1529.39
0303291 Reed,Debbie 1037010 33 1232.75
0286438 e Coy, Anmy M 1037010 18 1112.13
0299572 Ingram,Kathy 1037010 13 336.06
0011007 Duncan,Alicia 1037010 10 331.06
0271477 Wagner,Paige C 1037010 6 235.53
0299038 Capurso,Sarah 1037010 8 100.61
0292258 White.Jonathan 1037010 1 95.95
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Report

4

4

Step 54

Travel and Expenses > Manage Accounting > Print Reports >
Non-Reimbursable Expenses

Select Run Control

Enter GL Business Unit, Department, From Date, Through
Date

Save and Run
Retrieve from Report Manager

ORACLE Non-Reimbursable Expenses Page: 1 0f 1
EX_NONRMB_RPT PeopleSoft Expenses Run Date: 211372012
Report Parameters
GL Business Unit | 24000 Armstrong State University From Date | 07/01/2014
Department | 1037010 Through Date | 12/31/2014
Employee

3
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Query Changes

» See Handout

GeorgiaFIRST Financials v8.9 to v9.2 BOR Queries

8.9 Query Name

Description

9.2 Name

Additional Comments

BOR_EX_ALTUSERS

Lists Users with Alternates

BOR_EX_ALTUSER

Changed naming convention

BOR_EX_ALTUSER_EXPIRED

Expired Alt User Assignments

BOR_EX_ALTUSER_EXPIRED

BOR_EX_CASHADY_APPLIED

Cash Adv Issued & spplied

BOR_EX_CASHADV_APPLIED

BOR_EX_CASHADV_REIMB

Cash Adv Issued & Reimb

BOR_EX_CASHADV_REIMB

BOR_EX_CASHADY_TO_UNAPPLY

Cash Adv Issued & Applied

BOR_EX_CASHADV_TO_UNAPPLY

BOR_EX_DUE

Approved Transactions Mot Paid

BOR_EX_DUE

Added Payment Hold

BOR_EX_EXRPTS_BY_EXP_TYPE

ER Trans by Expense Type

BOR_EX_EXRPTS_BY_EXP_TYPE

BOR_FX_OPEN_CASHADV_BAL

Account 132300 Recon by Emplid

BOR_EX_OPEN_CASHADV_BAL

BOR_EX_OPEN_LIABILITY

Open Balances in 211500 Accoun

BOR_EX_OPEN_LIABILITY

BOR_EX_OPEN_PREPAID_BAL

Account 132160 Recon by Emplid

BOR_EX_OPEN_PREPAID_BAL

BOR_EX_UNPOSTED_ACCRUALS

Unposted Expense Accruals

BOR_EX_UNPOSTED_ACCRUALS

Changed to show POST_STATUS_EX <>PorC

BOR_EX_UNPOSTED_PYMNTS

Unposted Expense Payments

BOR_EX_UNPOSTED_PYMNTS

BOR_WF_BLACK_HOLE

EX trans to be reassigned

BOR_EX_WF_BLACK_HOLE

Added EX Prefix to Naming Convention

BOR_EMPLOYEE_DELETAGES

Authorized to enter exp for em

BOR_EX_EMPLOYEE_DELEGATES

Added EX Prefix to Naming Convention

BOR_EXPENSE_ADIJUSTMENTS

Expense Adjustments

BOR_EX_EXPENSE_ADJUSTMENTS

Added EX Prefix to Naming Convention

BOR_EX_SUBMITTED_BY

Submitted by Delegate

BOR_EX_SUBMITTED_RY

NEW query for 9.2

BOR_FX_PRIOR_BUD_REF

EX Trans with Priocr BUD_REF

BOR_EX_PRIOR_BUD_REF

NEW query delivered with Release 4.10

BOR_KK_EXCLOSE_RECON

EXCLOSE Source Tran fo KK

BOR_KE_EX_CLOZE_RECON

BOR_KK_EXSHEET_RECON

EXSHEET Source Trans to KK

BOR_KK_EXSHEET_RECON

BOR_KK_OPEN_TAUTH_ENC

Open Tauth Encumbrances

BOR_KK_OPEN_TAUTH_ENC

Changes delivered with Release 4.30. Remaoved criteria
status <= 'CLS', removed both approval dt fields, added
last_update_dt to end of select, added having

sum|{monetary_amount) <= 0, added budget_ref prompt

BOR_EX_CA_RECON

Paid_Reconciled EX Transaction

BOR_FX_DUE_SS

Approved Transactions Mot Paid

BOR_EX_EMP_HISTORY

Employee Expenses History

BOR_EX_FR_KK_RECON

Compares ExpRpts in EX and KK

BOR_EX_OPEN_EMPL_BAL

Open balances by employee

BOR_EX_OPEN_LIABILITY_IN_EX

Open balances in 211500 Account

BOR_EX_OPEN_LIABILITY_NOT_FND

Open halances in 211500 Account

BOR_EX_PYMNT_BY_DATE_RANGE

Payments by Expense Type

BOR_EX_PYMMNT_BY_EXP_TYPE

Payments by Expense Type

BOR_FX_TA_ER_CA_RECON

Consolidated View of EX Trans

BOR_EX_TA_KK_RECON

Compares TAuths in EX and KK

BOR_USERPROF_DESIGNATE

Ex User Profiles and Designate

Dropped in 9.2

Dropped per decision reached in Fit Gap
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Institutional Query Retrofits

EX_SHEET_LINE BEGIN_MILES_BOR

EX_SHEET_LINE COMMUTE_MILES_BOR EX_MIL_DTL BOR
EX_SHEET_LINE END_MILES BOR

EX_SHEET_LINE PERSONAL_MILES BOR

» If you have a query that used BEGIN_MILES_BOR,
END_MILES_BOR, etc. you may need to adjust your query
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